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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 1 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 2 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 3 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 4 
public-private partnership enables the creation of practical cybersecurity solutions for specific 5 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 6 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 7 
Fortune 50 market leaders to smaller companies specializing in IT security—the NCCoE applies standards 8 
and best practices to develop modular, easily adaptable example cybersecurity solutions using 9 
commercially available technology. The NCCoE documents these example solutions in the NIST Special 10 
Publication 1800 series, which maps capabilities to the NIST Cyber Security Framework and details the 11 
steps needed for another entity to recreate the example solution. The NCCoE was established in 2012 by 12 
NIST in partnership with the State of Maryland and Montgomery County, Md. 13 

To learn more about the NCCoE, visit https://nccoe.nist.gov. To learn more about NIST, visit 14 
https://www.nist.gov. 15 

NIST CYBERSECURITY PRACTICE GUIDES 16 

NIST Cybersecurity Practice Guides (Special Publication Series 1800) target specific cybersecurity 17 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 18 
adoption of standards-based approaches to cybersecurity. They show members of the information 19 
security community how to implement example solutions that help them align more easily with relevant 20 
standards and best practices and provide users with the materials lists, configuration files, and other 21 
information they need to implement a similar approach. 22 

The documents in this series describe example implementations of cybersecurity practices that 23 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 24 
or mandatory practices, nor do they carry statutory authority.  25 

ABSTRACT 26 

Businesses face a near-constant threat of destructive malware, ransomware, malicious insider activities, 27 
and even honest mistakes that can alter or destroy critical data. These data corruption events could 28 
cause a significant loss to a company’s reputation, business operations, and bottom line.   29 

These types of adverse events, that ultimately impact data integrity, can compromise critical corporate 30 
information including emails, employee records, financial records, and customer data. It is imperative 31 
for organizations to recover quickly from a data integrity attack and trust the accuracy and precision of 32 
the recovered data. 33 

https://nccoe.nist.gov/
https://www.nist.gov/
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The National Cybersecurity Center of Excellence (NCCoE) at NIST built a laboratory environment to 34 
explore methods to effectively recover from a data corruption event in various Information Technology 35 
(IT) enterprise environments. NCCoE also implemented auditing and reporting IT system use to support 36 
incident recovery and investigations.  37 

This NIST Cybersecurity Practice Guide demonstrates how organizations can implement technologies to 38 
take immediate action following a data corruption event. The example solution outlined in this guide 39 
encourages effective monitoring and detection of data corruption in standard, enterprise components 40 
as well as custom applications and data composed of open-source and commercially available 41 
components. 42 
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1 Introduction 126 

The following guides show IT professionals and security engineers how we implemented this data 127 
integrity solution example. We cover all the products employed in this reference design. We do not 128 
recreate the product manufacturers’ documentation, which is presumed to be widely available. Rather, 129 
these guides show how we integrated the products into our environment. 130 

Note: These are not comprehensive tutorials. There are many possible service and security configurations 131 
for these products that are out of scope for this reference design. 132 

1.1 Practice Guide Structure 133 

This NIST Cybersecurity Practice Guide demonstrates a standards-based reference design and provides 134 
users with the information they need to replicate the data integrity solution. This reference design is 135 
modular and can be deployed in whole or in parts. 136 

This guide contains three volumes: 137 

 NIST SP 1800-11a: Executive Summary 138 

 NIST SP 1800-11b: Approach, Architecture, and Security Characteristics – what we built and why 139 

 NIST SP 1800-11c: How-To Guides – instructions for building the example solution (you are here) 140 

Depending on your role in your organization, you may use this guide in different ways: 141 

Business decision makers, including chief security and technology officers, will be interested in the 142 
Executive Summary (NIST SP 1800-11a), which describes the: 143 

 challenges enterprises face in protecting their data from loss or corruption 144 

 example solution built at the National Cybersecurity Center of Excellence (NCCoE) 145 

 benefits of adopting the example solution 146 

Technology or security program managers who are concerned with how to identify, understand, assess, 147 
and mitigate risk will be interested in this part of the guide, NIST SP 1800-11b, which describes what we 148 
did and why. The following sections will be of particular interest: 149 

 Section 3.4.1, Assessing Risk Posture, provides a description of the risk analysis we performed. 150 

 Section 3.4.2, Security Control Map, maps the security characteristics of the example solution to 151 
cybersecurity standards and best practices. 152 

Consider sharing the Executive Summary (NIST SP 1800-11a) with your leadership team to help them 153 
understand the importance of adopting standards-based data integrity solutions. 154 
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IT professionals who want to implement an approach like this will find the whole practice guide useful. 155 
You can use the How-To portion of the guide (NIST SP 1800-11c) to replicate all or parts of the build 156 
created in our lab. The guide provides specific product installation, configuration, and integration 157 
instructions for implementing the example solution. We do not recreate the product manufacturers’ 158 
documentation, which is generally widely available. Rather, we show how we integrated the products in 159 
our environment to create an example solution. 160 

This guide assumes that IT professionals have experience implementing security products within the 161 
enterprise. While we used a suite of commercial products to address this challenge, this guide does not 162 
endorse these particular products. Your organization can adopt this solution or one that adheres to 163 
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing 164 
parts of the data integrity solution. Your organization’s security experts should identify the products that 165 
will best integrate with your existing tools and IT system infrastructure. We hope you will seek products 166 
that are congruent with applicable standards and best practices.  167 

A NIST cybersecurity practice guide does not describe “the” solution, but a possible solution. This is a 168 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 169 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to  170 
di-nccoe@nist.gov. 171 

1.2 Build Overview 172 

The NCCoE built a hybrid virtual-physical laboratory environment to explore methods to effectively 173 
recover from a data corruption event in various Information Technology (IT) enterprise environments. 174 
NCCoE also explored the issues of auditing and reporting that IT systems use to support incident 175 
recovery and investigations. The servers in the virtual environment were built to the hardware 176 
specifications of their specific software components.  177 

The NCCoE worked with members of the Data Integrity Community of Interest to develop a diverse (but 178 
non-comprehensive) set of use case scenarios against which to test the reference implementation. 179 
These are detailed in Volume B, Section 5.1. For a detailed description of our architecture, see Volume 180 
B, Section 4. 181 

mailto:di-nccoe@nist.gov
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1.3 Typographical Conventions 182 

The following table presents typographic conventions used in this volume. 183 

Typeface/ Symbol Meaning Example 

Italics filenames and pathnames 
references to documents 
that are not hyperlinks, new 
terms, and placeholders 

For detailed definitions of terms, see 
the NCCoE Glossary. 

Bold names of menus, options, 
command buttons and fields 

Choose File > Edit. 

Monospace command-line input, on-
screen computer output, 
sample code examples, sta-
tus codes 

mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the doc-
ument, a web URL, or an 
email address 

All publications from NIST’s National 
Cybersecurity Center of Excellence 
are available at http://nccoe.nist.gov 

2 Product Installation Guides 184 

This section of the practice guide contains detailed instructions for installing, configuring, and 185 
integrating all the products used to build an instance of the example solution. 186 

The products presented in this document have the potential to quickly change both interfaces and 187 
functionality. This document aims to highlight the core configurations an organization could use along 188 
with visual representations of those configurations.  189 

http://nccoe.nist.gov/
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2.1 Active Directory and Domain Name System (DNS) Server 190 

As part of our enterprise emulation, we included an Active Directory server that doubles as a DNS 191 
server. This section covers the installation and configuration process used to set up Active Directory and 192 
DNS on a Windows Server 2012 R2 machine. 193 

2.1.1 Installing Features 194 
1. Open Server Manager. 195 

 196 
2. Click the link Add Roles and Features.  197 
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3. Click Next.  198 

4. Select Role-based or feature-based installation. 199 

 200 
5. Click Next. 201 
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 202 
6. Select ADDNS (or the correct Windows Server name) from the list. 203 
7. Click Next. 204 

 205 
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8. Check the box next to Active Directory Domain Services. 206 

 207 

 208 
9. Click Add Features. 209 
10. Click Next. 210 
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 211 
11. Ensure that Group Policy Management, .NET Framework 4.5, TCP Port Sharing, Remote Server 212 

Administration Tools, and Windows PowerShell are selected. 213 

 214 
12. Select any additional features and click Add Features on the popup. 215 
13. Click Next. 216 
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 217 
14. Click Next. 218 

 219 
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 220 
15. Click Install.  221 
16. Wait for the installation to complete. 222 

 223 
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17. Select Post-Deployment Configuration or Promote this server to a domain controller. 224 

 225 
18. Select Add a new forest. 226 

 227 
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19. Enter a Root domain name. Example: DI.TEST. 228 

 229 
20. Click Next.  230 

 231 
21. Select Windows Server 2012 R2 for the Forest Functional Level.  232 
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22. Select Windows Server 2012 R2 for the Domain Functional Level. 233 
23. Check the box next to DNS server and Global Catalog. 234 
24. Do not check the box next to read-only domain controller. 235 
25. Specify a password for DSRM (D@T@Integrity#1). 236 

 237 
26. Click Next. 238 
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 239 
27. Click Next. 240 

 241 
28. Verify the NetBIOS name.  242 
29. Click Next. 243 
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 244 
30. Click Next. 245 

 246 
31. Click Next. 247 
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 248 
32. Click Install. 249 

 250 
33. The server automatically reboots. 251 
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2.1.2 Creating a Certificate Authority 252 
1. Open Server Manager. 253 

 254 
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2. Click the link Add Roles and Features. 255 

 256 
3. Click Next. 257 

 258 
4. Select Role-based or feature-based installation.  259 
5. Click Next. 260 
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 261 
6. Select ADDNS (or the correct Windows Server name) from the list. 262 
7. Click Next. 263 

 264 
8. Check the box next to Active Directory Certificate Services 265 
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 266 
9. Click Add Features. 267 

 268 
10. Click Next. 269 
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 270 
11. Click Next. 271 

 272 
12. Click Next. 273 
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 274 
13. Select Certification Authority on the Role Services list.  275 
14. Click Next. 276 

 277 
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 278 
15. Click Install.  279 
16. Select Configure Active Directory Certificate Services on the destination server. 280 

 281 
17. Click Next.  282 
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18. Select Certification Authority. 283 

 284 
19. Click Next.  285 

 286 
20. Select Enterprise CA.  287 
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21. Click Next.  288 

22. Select Root CA.  289 
23. Click Next. 290 



DRAFT 

NIST SP 1800-11C: Data Integrity  26 

24. Select Create a new private key. 291 

 292 
25. Click Next.  293 
26. Select RSA#Microsoft Software Key Storage Provider. 294 
27. Enter 2048 in the box. 295 
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28. Select SHA256 from the list. 296 

 297 
29. Click Next. 298 

 299 
30. Click Next.  300 
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31. Set the time to 5 years. 301 

 302 
32. Click Next. 303 

 304 
33. Click Next. 305 
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 306 
34. Click Configure. 307 

 308 
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2.1.3 Configure Account to Add Computers to Domain 309 
1. Open the start menu.  310 
2. Type dsa.msc and run the program. 311 

 312 
3. Right click on Users in the left pane. 313 

 314 
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4. Click Delegate Control. 315 

 316 
5. Click Next. 317 

 318 
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6. Click Add to add a user or group. Example: Domain Admins. 319 

 320 
7. When finished adding users or groups, click OK. 321 

 322 
8. Click Next. 323 
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9. Choose Create a custom task to delegate. 324 

 325 
10. Click Next. 326 

 327 
11. Choose Only the following objects in the folder.  328 
12. Select the Computer Objects check box. 329 
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13. Check the box for Create selected objects in this folder. 330 
14. Check the box for Delete selected objects in this folder. 331 

 332 
15. Click Next. 333 



DRAFT 

NIST SP 1800-11C: Data Integrity  35 

16. In the Permissions List, choose Reset Password, Read and write Account Restrictions, 334 
Validated write to DNS host name, Validated write to service principal name. 335 

 336 
17. Click Next. 337 

 338 
18. Observe the successful installation and click Finish. 339 
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2.1.4 Adding Machines to the Correct Domain 340 
1. Right click network icon in task bar.  341 
2. Click Open Network and Sharing center. 342 

 343 
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3. Click the link for editing the network interface under Connections. 344 

 345 
4. Click Properties. 346 
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 347 
5. Click Internet Protocol Version 4.  348 
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 349 
6. Click Properties.  350 
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7. Set the DNS field to the field of the AD/DNS server. 351 

 352 
8. Click OK. 353 
9. Exit out of the Network and Sharing Center 354 
10. Push the start menu button.  355 
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 356 
11. Go to This PC.  357 
12. Right click in the window and choose Properties.358 

 359 
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13. Under Name, domain, and workgroup settings, click Change settings.360 

 361 
14. Click Change.... 362 
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 363 
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15. Select Domain and enter the domain specified on the AD/DNS server.364 

 365 
16. Click OK. 366 

 367 
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17. Enter the credentials of an account in AD which has the right permissions to add a group to the 368 
domain. 369 

 370 
18. Click OK a few times and restart the server when prompted. 371 

 372 
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2.1.5 Configuring Active Directory to Audit Account Activity  373 
1. Open Local Security Policy from the Start Menu. 374 

 375 
2. Open Local Policies > Audit Policy. 376 

 377 
3. Right click Audit account management.  378 
4. Select Properties. 379 
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 380 
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 381 
5. Check the boxes next to Success and Failure. 382 
6. Click OK. 383 
7. Account management activities will now be reported to Windows Event Log – Security. 384 

2.2 Microsoft Exchange Server 385 

As part of our enterprise emulation, we include a Microsoft Exchange server. This section covers the 386 
installation and configuration process used to set up Microsoft Exchange on a Windows Server 2012 R2 387 
machine. 388 

2.2.1  Install Microsoft Exchange 389 
1. Run Exchange2016-x64.exe. 390 
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 391 
2. Choose the directory for the extracted files and press OK.392 

  393 
3. Enter the directory and run setup.exe. 394 

 395 
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4. Select Connect to the Internet and check for updates.396 

 397 
5. Wait for the check to finish. 398 
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 399 
6. Click Next. 400 
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 401 
7. Wait for the copying to finish. 402 
8. Click Next.  403 
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9. Click I accept the terms in the license agreement.404 

 405 
10. Click Next.  406 
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 407 
11. Click Use Recommended Settings. 408 
12. Click Next.  409 
13. Check Mailbox role. 410 
14. Check Automatically install Windows Server roles and features that are required to install 411 

Exchange Server. 412 
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 413 
15. Click Next. 414 
16. Specify the installation path for MS Exchange. 415 
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 416 
17. Click Next.  417 
18. Specify the name for the Exchange organization. Example: DI. 418 



DRAFT 

NIST SP 1800-11C: Data Integrity  57 

19. Decide whether to apply split permissions based on the needs of the enterprise.419 

 420 
20. Click Next. 421 
21. Click No. 422 
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 423 
22. Click Next.  424 
23. Install any prerequisites listed. 425 
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24. If necessary, restart the server and re-run setup.exe, following through steps 3-22 again.426 

 427 
25. Click Install. 428 
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 429 
26. Wait for setup to complete. 430 

2.3 SharePoint Server 431 

As part of our enterprise emulation, we include a Microsoft SharePoint server. This section covers the 432 
installation and configuration process used to set up SharePoint on a Windows Server 2012 R2 machine. 433 

2.3.1  Install Roles and Features 434 
1. Open Server Manager. 435 
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 436 
2. Click Manage. 437 

 438 
3. Click Add Roles and Features. 439 
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 440 
4. Click Next. 441 
5. Choose Role-based or feature-based installation. 442 

 443 
6. Click Next. 444 
7. Choose Select a server from the server pool. 445 
8. Choose the SharePoint server from the list. 446 
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 447 
9. Click Next. 448 
10. Check Application Server Role. 449 

 450 
11. Click Next. 451 
12. Check IIS Hostable Web Core. 452 
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 453 
13. Click Next. 454 

 455 
14. Click Next. 456 
15. Check all boxes under Application Server Role Services. 457 
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 458 
16. Click Next. 459 
17. Choose Create a self-signed certificate. 460 

 461 
18. Click Next. 462 
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 463 
19. Click Next. 464 
20. Check all boxes under Web Server (IIS) Role Services. 465 

 466 
21. Click Next. 467 
22. Check Restart the destination server automatically if required. 468 
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 469 
23. Click Install. 470 
24. The server may automatically restart. 471 
25. Right click the .ISO file for SharePoint Server. 472 
26. Choose Mount. 473 

2.3.2 Install SharePoint 474 
1. Navigate to the main directory of the ISO. 475 

 476 
2. Double click pre-requisite installer. 477 
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 478 
3. Click Next.  479 
4. Click I accept the terms of the License agreement. 480 

 481 
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5. Click Next. 482 
6. Resolve any dependencies and repeat steps 2-5. 483 

 484 
7. After the successful installation, click Finish. 485 
8. The server may automatically restart.  486 
9. Remount the .ISO file for SharePoint Server. 487 
10. Navigate to the main directory of the .ISO file. 488 
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 489 
11. Double click the program called setup. 490 

 491 
12. Click Install SharePoint Server. 492 
13. Enter your product key when prompted. 493 
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 494 
14. Click Continue.  495 
15. Check I accept the terms of this agreement. 496 

 497 
16. Click Continue. 498 
17. Choose which Server Type fits your organization's purposes. 499 
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 500 
18. Click Install Now.  501 
19. Wait for the installation to finish. 502 
20. Check Run the SharePoint Products Configuration Wizard now. 503 

 504 
21. Click Close. 505 
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2.3.3 SharePoint Products Configuration Wizard 506 

 507 
1. Click Next.  508 

 509 
2. Click Yes.  510 
3. Click Next. 511 
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4. Wait for the configuration to complete (it may take up to 30 minutes depending on your 512 
system). 513 

 514 
5. Click Finish. 515 

2.3.4 Configure SharePoint 516 
1. Open a browser and navigate to http://sharepoint (replace sharepoint with the hostname or IP 517 

address of the SharePoint server). 518 
2. Choose the type of SharePoint template that fits your business needs. Example: Enterprise > 519 

Document Center. 520 
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 521 

2.4 Windows Server Hyper-V Role 522 

As part of our simulated enterprise, we include a Windows Hyper-V server. This section covers the 523 
instructions for installing Windows Server Hyper-V on a Windows Server 2012 R2 machine. 524 

The instructions for enabling the Windows Server Hyper-V Role are retrieved from 525 
https://technet.microsoft.com/en-us/library/hh846766(v=ws.11).aspx and are replicated below for 526 
preservation and ease of use. 527 

2.4.1 Production Installation 528 
1. In Server Manager, on the Manage menu, click Add Roles and Features. 529 

https://technet.microsoft.com/en-us/library/hh846766(v=ws.11).aspx
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 530 
2. On the Before you begin page, verify that your destination server and network environment are 531 

prepared for the role and feature you want to install.  532 

 533 
3. Click Next. 534 
4. On the Select installation type page, select Role-based or feature-based installation. 535 
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 536 
5. Click Next. 537 
6. On the Select destination server page, select a server from the server pool. 538 

 539 
7. Click Next. 540 
8. On the Select server roles page, select Hyper-V. 541 
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9. To add the tools that you use to create and manage virtual machines, click Add Features. 542 

 543 
10. Click Next. 544 

 545 
11. Click Next. 546 
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 547 
12. Click Next. 548 
13. On the Create Virtual Switches page, select the appropriate options. 549 

 550 
14. Click Next.  551 
15. On the Virtual Machine Migration page, select the appropriate options. 552 
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 553 
16. Click Next. 554 
17. On the Default Stores page, select the appropriate options. 555 

 556 
18. Click Next.  557 
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19. On the Confirm installation selections page, select Restart the destination server automatically 558 
if required. 559 

 560 
20. Click Install. 561 
21. When installation is finished, verify that Hyper-V installed correctly. Open the All Servers page in 562 

Server Manager, select a server on which you installed Hyper-V. Check the Roles and 563 
Features tile on the page for the selected server. 564 

2.5 MS SQL Server 565 

As part of both our enterprise emulation and data integrity solution, we include a Microsoft SQL Server. 566 
This section covers the installation and configuration process used to set up Microsoft SQL Server on a 567 
Windows Server 2012 R2 machine. 568 

2.5.1  Install and Configure MS SQL 569 
1. Acquire SQL Server 2014 Installation Media. 570 
2. Locate the installation media in the machine and click on SQL2014_x64_ENU to launch SQL 571 

Server Installation Center. 572 
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 573 
3. On the left menu, select Installation. 574 

 575 
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4. Select New SQL Server stand-alone installation or add features to an existing installation. This 576 
will launch the SQL Server 2014 setup. 577 

 578 
5. In the Product Key section, enter your product key. 579 
6. Click Next. 580 
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 581 
7. In the License Terms section, read and click I accept the license terms. 582 
8. Click Next.  583 
9. In the Install Rules section, note and resolve any further conflicts.  584 
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 585 
10. Click Next. 586 
11. In the Setup Role section, select SQL Server Feature Installation.  587 

 588 
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12. Click Next. 589 
13. In the Feature Selection section, select the following: 590 

a. Database Engine Services 591 
b. Client Tools Connectivity 592 
c. Client Tools Backwards Compatibility 593 
d. Client Tools SDK 594 
e. Management Tools – Basic 595 
f. Management Tools – Complete 596 
g. SQL Client Connectivity SDK 597 
h. Any other desired features 598 

 599 
14. Click Next. 600 
15. In the Instance Configuration section, select Default instance. 601 
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 602 
16. Click Next. 603 

 604 
17. In the Server Configuration section, click Next. 605 
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18. In the Database Engine Configuration section, make sure Mixed Mode is selected. 606 
19. Add all desired users as Administrators under Specify SQL Server Administrators by pressing 607 

Add Current User. 608 
a. For Domain accounts, simply type in $DOMAINNAME\$USERNAME into Enter the 609 

object names to select textbox. 610 
b. Click OK. 611 
c. For local computer accounts, click on locations and select the computers name. 612 
d. Click OK. 613 
e. Type the username into the Enter the object names to select textbox. 614 
f. Once you are finished adding users, click Next. 615 

 616 

20. In the Ready to install section, verify the installation and click Install. 617 
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 618 
21. Wait for the install to finish.  619 

 620 
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2.5.2 Open Port on Firewall 621 
1. Open Windows Firewall with Advanced Security. 622 

 623 
2. Click Inbound Rules and then New Rule. 624 
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 625 
3. Select Port. 626 
4. Click Next.  627 
5. Select TCP and Specific local ports. 628 
6. Type 1433 into the text field. 629 
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 630 
7. Click Next. 631 
8. Select Allow the connection. 632 
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 633 
9. Click Next. 634 
10. Select all applicable locations. 635 
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 636 
11. Click Next.  637 
12. Name the rule Allow SQL Access. 638 
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 639 
13. Click Finish. 640 

2.5.3 Add a New Login to the Database 641 
1. Open SQL Server Management Studio. 642 

 643 
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2. Hit Connect to connect to the database. 644 
3. In the Object Explorer window, expand the Security folder. 645 

 646 
4. Right click on the Logins folder and click New Login…. 647 
5. Input the desired user. 648 

 649 
6. Click OK. 650 
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2.6 HPE ArcSight Enterprise Security Manager (ESM) 651 

HPE ArcSight Enterprise Security Manager is primarily a log collection/analysis tool with features for 652 
sorting, filtering, correlating, and reporting information from logs. It is adaptable to logs generated by 653 
various systems, applications, and security solutions.  654 

This installation guide assumes a pre-configured CentOS 7 Virtual Machine with ESM already installed 655 
and licensed. This section covers the installation and configuration process used to set up ArcSight 656 
agents on various machines. 657 

2.6.1 Install Individual ArcSight Windows Connectors 658 
1. Log in to your DNS server. 659 

 660 
2. Add the host name of the ESM server vm-esm691c to the DNS list and associate it with the IP 661 

address of the ESM server. 662 
3. Run the installation file ArcSight-7.4.0.7963.0-Connector-Win64. 663 
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 664 
4. Wait for the initial setup to finish. 665 

 666 
5. Click Next. 667 
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6. Choose a destination folder. Note: It is recommended to change the default destination folder 668 
to <default>\Windows. This is to avoid conflicts if you wish to install more than one connector. 669 

 670 
7. Click Next. 671 

 672 
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8. Click Next. 673 

 674 
9. Click Install. 675 
10. Wait for the installation to finish. 676 
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 677 
11. Select Add a Connector. 678 
12. Click Next. 679 
13. Choose Microsoft Windows Event Log - Native from the list. 680 
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 681 
14. Click Next. 682 
15. Check Security log, System log, and Application Log. 683 
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 684 
16. Click Next. 685 
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 686 
17. Click Next. 687 
18. Choose ArcSight Manager (encrypted). 688 
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 689 
19. Click Next. 690 
20. For Manager Hostname, put vm-esm691c, or the hostname of your ESM server. 691 
21. For Manager Port, put 8443 (or the port that ESM is running on) on the ESM server. 692 
22. Enter the username and password used for logging into ArcSight Command Center. Default: 693 

(admin/password) 694 
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 695 
23. Click Next. 696 
24. Set identifying details about the system to help identify the connector (include a value for 697 

Name; the rest is optional). 698 
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 699 
25. Click Next. 700 
26. Select Import the certificate to connector from destination. This will fail if the Manager 701 

Hostname does not match the hostname of the Virtual Machine. 702 
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 703 
27. Click Next. 704 
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 705 
28. Click Next. 706 
29. Choose Install as a service. 707 
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 708 
30. Click Next.  709 



DRAFT 

NIST SP 1800-11C: Data Integrity  111 

 710 
31. Click Next. 711 
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 712 
32. Click Next.  713 
33. Choose Exit. 714 
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 715 
34. Click Next.  716 

 717 
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35. Click Done. 718 
36. Open Task Manager. 719 
37. Click More Details. 720 

 721 
38. Go to the Services tab. 722 
39. Find the service just created for ArcSight and right click it. 723 



DRAFT 

NIST SP 1800-11C: Data Integrity  115 

 724 
40. Choose Start. 725 



DRAFT 

NIST SP 1800-11C: Data Integrity  116 

 726 
41. The machine will now report its logs to ArcSight ESM. 727 

2.6.2 Install a Connector Server for ESM on Windows 2012 R2 728 
1. Run the installation file ArcSight-7.4.0.7963.0-Connector-Win64. 729 
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 730 
2. Wait for the initial setup to finish. 731 

 732 
3. Click Next. 733 
4. Choose a destination folder. Note: It is recommended to change the default destination folder 734 

to <default>\Windows. This is to avoid conflicts if you wish to install more than one connector. 735 
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 736 
5. Click Next. 737 

 738 
6. Click Next. 739 
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 740 
7. Click Install. 741 
8. Wait for the installation to finish. 742 
9. Select Add a Connector. 743 

 744 
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10. Click Next. 745 
11. Choose Microsoft Windows Event Log - Native from the list. 746 

 747 
12. Click Next. 748 
13. Check Security log, System log, Application Log. 749 
14. Check Use Active Directory. 750 
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 751 
15. Click Next. 752 
16. Fill out the form with the appropriate information for your Active Directory server. It is 753 

recommended to create an account on Active Directory specifically for ArcSight. 754 
17. Select Replace Hosts for Use Active Directory host results for. 755 
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 756 
18. Click Next. 757 
19. Select all the event types you would like forwarded from each machine. 758 

 759 
20. Click Next. 760 
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 761 
21. Click Next. 762 
22. Choose ArcSight Manager (encrypted). 763 

 764 
23. Click Next. 765 
24. For Manager Hostname, use vm-esm691c or the hostname of your ESM server. 766 
25. For Manager Port, use 8443 (or the port that ESM is running on) on the ESM server. 767 
26. Enter the username and password used for logging into ArcSight Command Center. Default: 768 

(admin/password) 769 
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 770 
27. Click Next. 771 
28. Set identifying details about the system to help identify the connector (include Name; the rest is 772 

optional). 773 

 774 
29. Click Next. 775 
30. Select Import the certificate to connector from destination. This will fail if the Manager 776 

Hostname does not match the hostname of the VM. 777 
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 778 
31. Click Next. 779 

 780 
32. Click Next. 781 
33. Choose Install as a service. 782 
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 783 
34. Click Next.  784 
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 785 
35. Click Next.  786 
36. Choose Exit. 787 
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 788 
37. Click Next. 789 

 790 
38. Click Done. 791 
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39. Open Task Manager. 792 
40. Click More Details. 793 

 794 
41. Go to the Services tab. 795 
42. Find the service just created for ArcSight and right click it. 796 
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 797 
43. Choose Start. 798 
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 799 
44. The machine will now report all collected Windows logs to ArcSight ESM. 800 

2.6.3 Install Syslog Connector for Ubuntu 801 
1. Run ./ArcSight-7.4.0.7963.0-Connector-Linux64.bin. 802 
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 803 
2. Click Next. 804 
3. Choose a folder to install the connector in. 805 

 806 
4. Click Next. 807 
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 808 
5. Click Next. 809 

 810 
6. Click Install. 811 
7. Choose Add a Connector. 812 
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 813 
8. Click Next. 814 
9. Choose Syslog File. 815 
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 816 
10. Click Next. 817 
11. For File Absolute Path Name, select a log file from which to forward events to ESM. Example: 818 

/var/log/syslog 819 
12. Select realtime to have events be streamed or batch to have events sent over in sets. 820 
13. For Action upon Reaching EOF, select None. 821 
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 822 
14. Click Next. 823 
15. Select ArcSight Manager (encrypted). 824 
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 825 
16. Click Next. 826 
17. For Manager Hostname, put vm-esm691c or the hostname of your ESM server. (You may need 827 

to add dns-search.di.test to /etc/network/interfaces if the hostname does not resolve on its 828 
own. For example, vm-esm691c.di.test may resolve but vm-esm691c may not.) 829 

18. For Manager Port, put 8443 (or the port that ESM is running on) on the ESM server. 830 
19. Enter the username and password used for logging into ArcSight Command Center. Default: 831 

(admin/password) 832 
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 833 
20. Click Next. 834 
21. Set identifying details about the system to help identify the connector (include Name; the rest is 835 

optional). 836 
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 837 
22. Click Next. 838 
23. Choose Import the certificate to connector from destination. 839 
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 840 
24. Click Next. 841 
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 842 
25. Click Next. 843 
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  844 
26. Click Next. 845 
27. Choose Exit. 846 
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 847 
28. Click Next. 848 

 849 
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29. Click Done. 850 

2.7 IBM Spectrum Protect  851 

IBM Spectrum Protect is a backup/restore solution that makes use of cloud-based object storage. It 852 
allows for administrative management of backups across an enterprise, providing users with 853 
mechanisms to restore their data on a file level. This section covers the installation and configuration 854 
process used to set up IBM Spectrum Protect on a Windows Server 2012 R2 machine, as well as the 855 
installation and configuration processes required for installing the backup/archive client on various 856 
machines. 857 

2.7.1 Install IBM Spectrum Protect Server 858 
1. You may need to disable Run all administrators in Admin Approval Mode. To do this go to 859 

Control Panel > Administrative Tools > Local Security Policy > Local Policies > Security 860 
Options. Double click the User Account Control: Run all administrators in Admin Approval 861 
Mode section. Select Disable and click OK. Restart the computer. 862 

863 



DRAFT 

NIST SP 1800-11C: Data Integrity  145 

864 

865 
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 866 
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2. Run WIN_SER_STG_ML in its own folder to extract the contents.867 

 868 
3. Run the install script.  869 
4. Make sure all the boxes are checked. 870 

 871 
5. Click Next.  872 
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6. Read and select I accept the terms in the license agreement. 873 

 874 
7. Click Next.  875 
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8. Select the location for files to be installed to. 876 

 877 
9. Click Next. 878 

 879 
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10. Click Next. 880 
11. Make sure all the packages are checked. 881 

 882 
12. Click Next. 883 
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13. Select IBM Spectrum Protect.884 

 885 
14. Click Next.  886 
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15. Read and select I accept the terms in the license agreement.887 

 888 
16. Click Next.  889 
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17. Read and select I accept the terms in the license agreement.890 

 891 
18. Click Next. 892 
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19. Specify 11090 for the port. 893 

 894 
20. Click Next.  895 
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21. Select Strict for the SP800-131a Compliance.896 

 897 
22. Click Next.  898 
23. Create a password. 899 
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 900 

24. Click Next.  901 

 902 
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25. Click Install. 903 
26. Wait for the install to finish. 904 

 905 

27. Click Finish. 906 
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 907 

2.7.2 Install IBM Spectrum Protect Client Management Services 908 
1. Run WIN64_CMS_ML in its own folder to extract the contents.909 

 910 
2. Run the install script. 911 
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 912 
3. Click Install. 913 
4. Check the box next to IBM Spectrum Protect Client Management Services.914 

 915 
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5. Click Next. 916 
6. Select Use the existing package group.917 

 918 
7. Click Next. 919 
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8. Make sure all the boxes next to the package Client Management Services are checked.920 

 921 
9. Click Next.  922 
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10. Set the port to 9028.923 

 924 
11. Click Next.  925 
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12. Click Strict for SP800-131a compliance.926 

 927 
13. Click Next. 928 

 929 
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14. Click Install. 930 

 931 

15. Observe the successful installation and click Finish. 932 
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2.7.3 Configure IBM Spectrum Protect 933 
1. Go to Start > IBM Spectrum Protect Configuration Wizard.934 

 935 
2. Click OK. 936 
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 937 
3. Click Next. 938 
4. Specify a name and an account for the IBM server to use. Example: (name: BACKSRVR, User ID: 939 

DI\spadmin). 940 
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 941 
5. Click Next. 942 
6. Choose a directory. 943 

 944 



DRAFT 

NIST SP 1800-11C: Data Integrity  168 

7. Click Next. 945 
8. Click Yes if prompted to create the directory. 946 
9. Choose The database directories are listed below. 947 
10. Create a directory to contain the database. Example: C:\BACKSRVR\IBMBackupServer. 948 
11. Enter the directory in the space provided.949 

 950 
12. Click Next. 951 
13. Create directories for logs and archive logs. Example: C:\BACKSRVR\IBMBackupServerLogs, 952 

C:\BACKSRVR\IBMBackupServerArchiveLogs. 953 
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14. Enter the directories in their respective fields.954 

 955 
15. Click Next. 956 
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16. Specify the server name. 957 

 958 
17. Click Next. 959 
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18. Specify an Administrator account.960 

 961 
19. Click Next.  962 
20. Select a port. Example: 1500. 963 
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21. Check the box next to Enable SSL Communication and enter a port. Example: 23444.964 

 965 
22. Click Next. 966 

 967 
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23. Click Next.  968 
24. Wait for the installation to finish.969 

 970 
25. Click Next. 971 
26. Click Done. 972 
27. Log in to Operations Center by going to localhost:11090/oc/. If issues occur, check firewall 973 

permissions for ports 1500 and 23444 (or whichever ports were designated in steps 20 and 21).974 

 975 
28. Log in using the credentials provided in the Configuration Wizard. 976 
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29. Enter the password for a new account to be created on the system.977 

 978 
30. Click Next. 979 
31. Select the time interval for data collection.980 

 981 
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32. Click Next. 982 
33. Select time intervals that suit your organization's needs.983 

 984 
34. Click Configure. 985 

 986 
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2.7.4 Adding Clients to IBM Spectrum Protect 987 
1. Log in to Operations Center.988 

 989 
2. Add clients by clicking the Clients tab.990 

 991 
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3. Click +Client.\ 992 

 993 
4. Select the server running the IBM backup capabilities. 994 
5. Check the box next to Always use for SSL.995 

 996 
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6. Click Next.  997 
7. Enter the name of a client machine that you want to be able to backup data from and a 998 

password. 999 
8. Decide whether to use Client-side deduplication (it reduces the required storage space for 1000 

backups). 1001 

 1002 
9. Click Next. Note the information on the next page as it is required to connect the server to the 1003 

client. 1004 
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 1005 
10. Click Next. 1006 

 1007 
11. Click Next. 1008 
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 1009 
12. Click Next. 1010 

 1011 
13. Click Next.  1012 
14. Select Default. 1013 
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 1014 
15. Click Add Client. 1015 

 1016 
16. Make sure to allow the ports for SSL and TCP traffic through the firewall (23444, 1500). 1017 
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17. Run the following command to set cert256.arm as the default certificate on the IBM Backup 1018 
server. Execute this command from the root server directory. Example: C:\Program 1019 
Files\Tivoli\TSM\BACKSRVR 1020 

> gsk8capicmd_64 -cert -setdefault -db cert.kdb -stashed -label "TSM Server 1021 
SelfSigned SHA Key" 1022 

Note: By default, gsk8capicmd_64 is located at C:\Program Files\Common 1023 
Files\Tivoli\TSM\api64\gsk8\bin. 1024 

 1025 
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2.7.5 Install the Spectrum Protect Client on Windows 1026 
1. Extract SP_CLIENT_8.1_WIN_ML 1027 

 1028 
2. Run the spinstall script (install any prerequisites required).1029 

 1030 
3. Click Next. 1031 
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4. Specify an installation path.1032 

 1033 
5. Click Next.  1034 
6. Select Custom Install. 1035 

 1036 
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7. Click Next. Make sure that all packages are selected for installation.1037 

 1038 
8. Click Next. 1039 

 1040 
9. Click Install. 1041 
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 1042 
10. Click Finish. 1043 
11. Run Backup-Archive GUI from the Start menu. This should open the IBM Spectrum Protect 1044 

Client Configuration Wizard.1045 

 1046 
12. Click Next.  1047 
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13. Select Create a new options file.1048 

 1049 
14. Click Next.  1050 
15. Enter the Node Name that you created in the Operations Center. 1051 

 1052 
16. Click Next.  1053 
17. If prompted, allow the program through the firewall.  1054 
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18. Select TCP/IP for the communication method.1055 

 1056 
19. Click Next. 1057 
20. Specify the IP address of the server running the IBM backup server.  1058 
21. Specify the port that the server is accepting connections on (Example: 23444).1059 

 1060 
22. Click Next.  1061 
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23. Click Select All or choose specific items from the recommended list of inclusions/exclusions. 1062 

 1063 
24. Click Next.  1064 
25. Select certain file types to exclude from backup, if any.1065 

 1066 
26. Click Next.  1067 
27. Check the box next to Backup all local file systems. 1068 
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28. Select Incremental for the Backup Type.1069 

 1070 
29. Click Next. 1071 

 1072 
30. Click Apply.  1073 
31. Click Finish.  1074 
32. In the Backup-Archive GUI (you may have to log in using the credentials specified on the server 1075 

or you may have to choose to ignore a warning that you couldn't connect), go to Edit > Client 1076 
Preferences. 1077 
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 1078 
33. Click Communication. 1079 
34. Ensure that the server address is correct and that the ports point to your SSL port (23444). 1080 
35. Check the boxes next to Send transaction to the server immediately, Use Secure Sockets Layer 1081 

(SSL), and Require TLS 1.2 or above. 1082 
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36. Select Yes for SSL is Required.1083 

 1084 
37. Click OK. 1085 
38. Retrieve cert256.arm from the server. 1086 
39. On the client machine, create a new key database by running the following commands: 1087 

> set PATH=C:\Program Files\Common 1088 
Files\Tivoli\TSM\api64\gsk8\bin\;C:\Program Files\Common 1089 
Files\Tivoli\TSM\api64\gsk8\lib64;%PATH% 1090 

> gsk8capicmd_64 -keydb -create -populate -db dsmcert.kdb -pw password -1091 
stash 1092 
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 1093 

40. Import cert256.arm by running the command: 1094 

> gsk8capicmd_64 -cert -add -db dsmcert.kdb -stashed -label "TSM server 1095 
BACKSRVR self-signed key" -file <path-to-cert256.arm> -format asci 1096 

 1097 
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41. Copy the resulting dsmcert.kdb and dsmcert.sth to C:\Program Files\Tivoli\TSM\baclient.1098 

 1099 

2.7.6 Install the Spectrum Protect Client on Ubuntu 1100 
1. Extract SP_CLIENT_8.1_LIN86_ML.tar.gz.1101 

 1102 
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2. Navigate to TSMCLI_LNX/tsmcli/linux86_DEB.1103 

 1104 
3. Install all the .deb files in this directory, except tivsm-jbb.amd64.deb, by running the following 1105 

command (they must be dpkg'd individually since they have interdependencies): 1106 
a. dpkg -i [name of package].deb 1107 

 1108 
4. Issue the following commands to setup the options files: 1109 

a. cd /opt/tivoli/tsm/client/ba/bin 1110 
b. mv dsm.sys.smp dsm.sys 1111 
c. mv dsm.opt.smp dsm.opt 1112 
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 1113 
5. Install Java with: 1114 

a. sudo apt-get install default-jre 1115 

 1116 
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6. Run dsmj to start the Java BAClient. 1117 

 1118 
7. After about 5 minutes, it will be unable to connect and will ask if you wish to start the client  1119 

anyway. Click Yes. 1120 

 1121 
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8. Open Edit > Client Preferences. Enter the node name as the name of the client you added to the 1122 
Spectrum Protect server.1123 

 1124 
9. Click the Communication tab. 1125 
10. Enter the IP Address for the server. 1126 
11. Enter the Server port and Admin port (23444). 1127 
12. Check the boxes next to Send transaction to the server immediately, Use Secure Sockets Layer 1128 

(SSL), and Require TLS 1.2 or above. 1129 
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13. Select Yes for SSL is Required.1130 

 1131 
14. Click OK.  1132 
15. Retrieve cert256.arm from the server. 1133 
16. On the client machine create a new key database by running the following commands: 1134 

> gsk8capicmd_64 -keydb -create -populate -db dsmcert.kdb -pw password -1135 
stash 1136 
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 1137 

17. Import cert256.arm by running the command: 1138 

> gsk8capicmd_64 -cert -add -db dsmcert.kdb -stashed -label "TSM server 1139 
BACKSRVR self-signed key" -file <path-to-cert256.arm> -format asci 1140 

 1141 
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18. Copy the resulting "dsmcert.kdb" and "dsmcert.sth" to /opt/tivoli/tsm/client/ba/bin.1142 

 1143 
19. You may be asked to reconfigure the dsm.opt file when setting up the scheduler but the options 1144 

should be filled out already.  1145 
20. To start the scheduler as a background process, run the following command: 1146 

> nohup dsmc schedule 2>/dev/null & 1147 

 1148 

21. You can add this command to the startup programs in Ubuntu to make it start automatically. 1149 

2.8 GreenTec WORMdisks 1150 

See the Installation of GreenTec Command Line Utilities document, that should accompany the 1151 
installation disk, for a detailed guide on how to install the GreenTec command line utilities. 1152 
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Furthermore, refer to the GT_WinStatus User Guide , that should also accompany the installation disk, 1153 
for instructions on how to effectively use GreenTec disks to preserve data. Read these instructions 1154 
carefully, as locking GreenTec WORMdisks can result in making some or all of the disk or the entire disk 1155 
unusable. Having portions of the disk, or the entire disk, permanently locked is sometimes desirable but 1156 
it is dependent on the needs of your organization. For example, if you want to store backup information 1157 
or logs securely.  1158 

 1159 

The GT_WinStatus User Guide provides instructions for locking and temporarily locking disk sectors. In 1160 
this practice guide, we will not include instructions on when or how to lock GreenTec disks. However, in 1161 
some cases, we will provide instructions detailing how to save data to these disks and leave locking 1162 
them to the implementing parties. 1163 

2.9 Veeam Backup & Replication 1164 

Veeam’s Backup & Replication tool provides backup and restore capabilities. In the data integrity 1165 
solution, Veeam is used to backup and restore virtual machines residing within Windows Server Hyper-1166 
V. In this section is the installation and configuration process for Veeam Backup & Replication on a 1167 
Windows Server 2012 R2 machine. Additional installation and configuration instructions can be found at 1168 
https://helpcenter.veeam.com/docs/backup/hyperv/install_vbr.html?ver=95. 1169 

2.9.1 Production Installation 1170 
1. Start the Veeam Setup Wizard and click to begin the installation process for Veeam Backup & 1171 

Replication with the appropriate version number. 1172 

https://helpcenter.veeam.com/docs/backup/hyperv/install_vbr.html?ver=95
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 1173 
2. Read and accept the license agreement. 1174 

 1175 
3. Click Next. 1176 
4. Browse to the location of the license file. 1177 
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 1178 
5. Click Next. 1179 
6. Select installation components required by your organization. 1180 

 1181 
7. Click Next. 1182 
8. Specify account credentials for Service account. 1183 
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 1184 
9. Click Next. 1185 
10. Specify details of the SQL Server Instance. 1186 

 1187 
11. Click Next. 1188 
12. Specify port numbers for Veaam Backup & Replication services. 1189 
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 1190 
13. Click Next. 1191 
14. Specify data storage locations. 1192 

 1193 
15. Click Next. 1194 
16. Review installation and configuration details and click Install. 1195 
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 1196 
17. Observe the successful installation and click Finish. 1197 

 1198 
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2.10  Tripwire Enterprise and Tripwire Log Center (TLC) 1199 

Tripwire Enterprise is a data integrity solution that monitors file activity and associated information 1200 
across an enterprise. In this solution, we use it to monitor both a MS SQL database and file changes in 1201 
certain folders. Tripwire Log Center allows for the collection and standardization of logs produced by 1202 
Tripwire Enterprise. 1203 

Please see the Tripwire Enterprise Install and Maintenance Guide, accessible at 1204 
http://download.tripwire.com/te_en/docs852/te_install_and_maint_guide.pdf?V2ymLyYUTw_9Yx-1205 
EB3c3uKKO7JcgvOihm3YK_zuCGJtyYm5c9NPiogn8hIakZL3NlLqa, for a detailed, illustrated guide to the 1206 
installation. The only addition to this documentation is that the MS SQL Server should be in “Mixed 1207 
Mode” for authentication purposes. This section covers the installation and configuration process we 1208 
used to set up Tripwire Agents on various machines as well as the installation and integration of Tripwire 1209 
Log Center with Tripwire Enterprise. The result of this integration is the generation and forwarding of 1210 
events from Tripwire Enterprise to Tripwire Log Center.  1211 

2.10.1 Install Tripwire Agent on Windows 1212 
1. Run te_agent.msi on the client machine. 1213 

 1214 
2. Click Next.  1215 
3. Accept the license agreement. 1216 

http://download.tripwire.com/te_en/docs852/te_install_and_maint_guide.pdf?V2ymLyYUTw_9Yx-EB3c3uKKO7JcgvOihm3YK_zuCGJtyYm5c9NPiogn8hIakZL3NlLqa
http://download.tripwire.com/te_en/docs852/te_install_and_maint_guide.pdf?V2ymLyYUTw_9Yx-EB3c3uKKO7JcgvOihm3YK_zuCGJtyYm5c9NPiogn8hIakZL3NlLqa
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 1217 
4. Click Next. 1218 
5. Specify the installation path. 1219 
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 1220 
6. Click Next.  1221 
7. Enter the IP address of the Tripwire server.  1222 
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 1223 
8. Click Next.  1224 
9. Leave the proxy settings blank. 1225 
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 1226 
10. Click Next. 1227 
11. Enter the services password specified in the server upon installation twice.  1228 
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 1229 
12. Click Next. 1230 

 1231 
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13. Click Install.  1232 
14. Start Tripwire Agent from the start menu (on some systems it may start automatically - check 1233 

services.msc to verify that it is running). 1234 

2.10.2  Install Tripwire Agent on Ubuntu 1235 
1. Execute the following commands as root. 1236 
2. Run te_agent.bin by issuing the command: 1237 

a. ./te_agent.bin 1238 

 1239 
3. Press Enter repeatedly to read through the EULA. 1240 

 1241 
4. Enter Y to accept the EULA. 1242 
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 1243 
5. Press Enter. 1244 
6. Enter the IP address of the Tripwire server.  1245 

 1246 
7. Press Enter. 1247 
8. Enter Y if the address was entered correctly. 1248 



DRAFT 

NIST SP 1800-11C: Data Integrity  216 

 1249 
9. Press Enter. 1250 

 1251 
10. Press Enter. 1252 
11. Enter Y to use the default port number. 1253 
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 1254 
12. Press Enter. 1255 
13. Enter N to disable the use of the Federal Information Processing Standard (FIPS), unless your 1256 

system requires the use of FIPS. 1257 

 1258 
14. Press Enter. 1259 
15. Enter the services password twice, pressing Enter after each time. Note that no text will appear 1260 

while typing the password. 1261 
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 1262 
16. Press Enter to skip using a proxy.  1263 

 1264 
17. Press Y. 1265 
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 1266 
18. Press Enter.  1267 
19. Press Y to install Real Time Monitoring. 1268 

 1269 
20. Press Enter. 1270 
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 1271 
21. Press Enter to accept the default port. 1272 
22. Press Y. 1273 

 1274 
23. Press Enter. 1275 
24. The agent should install. 1276 
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 1277 
25. Run the following commands as root: 1278 

b. cd "/usr/local/tripwire/te/agent/bin" 1279 

 1280 
c. ./twdaemon start 1281 
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 1282 

26. You may need to change /etc/hosts in Debian systems if there is a line which looks like this: 1283 

127.0.1.1    <hostname> 1284 

Change this to: 1285 

 <IP of machine>    <hostname> 1286 

 Otherwise, Tripwire Enterprise may consider multiple Debian machines as the same machine in 1287 
the assets view of Tripwire Enterprise. 1288 

 1289 
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2.10.3  Install Tripwire Log Center 1290 
See the Tripwire Log Center 7.2.4 Installation Guide that should accompany the installation media for 1291 
instructions on how to install TLC. Use the Tripwire Log Center Manager installer.  1292 

Notes:  1293 

a. It is recommended that you install Tripwire Log Center on a separate system from Tripwire 1294 
Enterprise.  1295 

b. You will need to install JRE8 and the Crypto library. Instructions are also in the Tripwire Log 1296 
Center Installation Guide. 1297 

c. You may need to unblock port 9898 on your firewall for the Tripwire enterprise agents.  1298 
d. Do not install PostgreSQL if you wish to use a database on another system. 1299 
e. When it finishes installing there should be a configuration wizard.  1300 

2.10.4  Configure Tripwire Log Center 1301 
1. Click Start. 1302 

 1303 
2. Click New Install. 1304 
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 1305 
3. Click Authorize. 1306 
4. An error may appear asking you to install .NET 3.5. 1307 
5. To do this, open Server Manager. 1308 
6. Click Manage. 1309 
7. Click Add Roles and Features. 1310 
8. Click Next. 1311 
9. Select Role-based or feature-based installation. 1312 
10. Click Next. 1313 
11. Select the current server from the list. 1314 
12. Click Next.  1315 
13. Click Next. 1316 
14. Check the box next to .NET Framework 3.5 Features. 1317 
15. Click Install. 1318 
16. Wait for the installation to finish.  1319 
17. If prompted, enter Name, Organization, Serial Number, and email address in the fields. Click 1320 

Register. This step will not appear if the software has already been registered 1321 
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 1322 
18. Click Close.  1323 
19. Continue with the configuration wizard.  1324 
20. Enter appropriate details for your Database Software. 1325 
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 1326 
21. Select Use Windows Authentication. 1327 
22. Click Next. 1328 
23. Select a directory to store log messages in. Example: C:\Program Files\Tripwire\Tripwire Log 1329 

Center Manager\Logs\AUDIT 1330 
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 1331 
24. Click Next.  1332 
25. Create an Administrator password and enter it twice. 1333 
26. Enter your email address.  1334 
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 1335 
27. Click Next.  1336 
28. Select authenticate with the local windows system user account. 1337 
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 1338 
29. Click Next.  1339 
30. Select any log sources that you expect to collect using Tripwire Log Center. Examples: Tripwire 1340 

Enterprise, Windows 10, Tripwire IP360 VnE, Linux Debian, Linux Ubuntu, Microsoft Exchange, 1341 
Microsoft SQL Server. 1342 
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 1343 
31. Click Next. 1344 
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 1345 
32. Click Start. 1346 
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 1347 
33. Click Next when the configuration finishes. 1348 
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 1349 
34. Observe the successful installation and click Finish.  1350 

2.10.5  Install Tripwire Log Center Console 1351 
See chapter 4 of Tripwire Log Center 7.2.4 installation guide for instructions on how to install Tripwire 1352 
Log Center Console. Use the Tripwire Log Center Console installer. This can be done on any system, 1353 
even the system running.  1354 

2.10.6  Integrate Tripwire Log Center Tripwire Log Center with Tripwire Enterprise 1355 
1. Create a user account in Tripwire Log Center by logging into Tripwire Log Center Console.  1356 
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 1357 
2. Click the Administration Manager button. 1358 

 1359 
3. On the side bar, click User Accounts. 1360 
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 1361 
4. Click the Add button. 1362 
5. Enter the details of the user.  1363 

 1364 
6. Double click the user account.  1365 
7. Select the Permissions tab.  1366 
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 1367 
8. Click Change User Permissions. 1368 
9. Select Databases and check the box. 1369 
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 1370 
10. Select API and check the box.  1371 

 1372 

11. Click OK. 1373 
12. Click OK. 1374 
13. Click OK. 1375 
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 1376 
14. Open Tripwire Enterprise by going to https://tripwire/. 1377 
15. Log in to the Tripwire Enterprise Console.  1378 

 1379 
16. Click Settings. 1380 
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 1381 
17. Go to System > Log Management. 1382 
18. Check the box next to Forward TE log messages to syslog. 1383 
19. Enter the IP address and port of the Tripwire Log Center server. The default port is 1468.  1384 
20. Check the box next to Allow TE to use information from Tripwire Log Center. 1385 
21. Enter the service address like this: https://192.168.50.44:8091/tlc, replacing the IP address with 1386 

the IP address of the Tripwire Log Center server. 1387 
22. Enter the account information for the account created with the Databases and API permissions. 1388 

 1389 
23. Click Apply. 1390 
24. Click OK. 1391 
25. Go back to the Tripwire Log Center Console. 1392 
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 1393 
26. Click Configuration Manager. 1394 

 1395 
27. Click Resources > Tripwire Enterprise Servers. 1396 
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 1397 
28. Click Add. 1398 
29. Enter a name for the Tripwire Enterprise server.  1399 
30. Enter the IP address and port for the Tripwire Enterprise server. By default, Tripwire Log Center 1400 

and Tripwire Enterprise will communicate on port 443. (https://192.168.50.43) 1401 
31. Enter the name of a user account on the Tripwire Enterprise server. The account must have the 1402 

following permissions: create, delete, link, load, update, view. 1403 

 1404 
32. Click Save. 1405 
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2.11  Integration: Tripwire Log Center (TLC) and HPE ArcSight ESM 1406 

In this section is a process for integrating Tripwire Log Center and HPE ArcSight ESM. This integration 1407 
assumes the correct implementation of Tripwire and ArcSight as described in earlier sections. The result 1408 
of this integration is the forwarding of logs generated by Tripwire Enterprise to ArcSight ESM as well as a 1409 
method for filtering specifically for file change events in ArcSight ESM.  1410 

2.11.1  Integrating TLC and ESM 1411 
1. Run ArcSight-7.4.0.7963.0-Connector-Win64 on any Windows server (except for the server 1412 

running the Tripwire Log Center).  1413 

 1414 
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 1415 
2. Click Next. 1416 
3. Specify a folder to install the connector. 1417 

 1418 
4. Click Next. 1419 
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 1420 
5. Click Next. 1421 
6. Click Install.  1422 
7. Select Add a Connector. 1423 
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 1424 
8. Click Next.  1425 
9. Select Syslog daemon. 1426 
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 1427 
10. Click Next.  1428 
11. Select a port for the daemon to run on.  1429 
12. Leave IP address as (ALL). 1430 
13. Select Raw TCP for Protocol.  1431 
14. Select False for Forwarder. 1432 
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 1433 
15. Click Next. 1434 
16. Choose ArcSight Manager (encrypted). 1435 
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 1436 
17. Click Next. 1437 
18. For Manager Hostname, put vm-esm691c or the hostname of your ESM server. 1438 
19. For Manager Port, put 8443 (or the port that ESM is running on). 1439 
20. Enter the username and password used for logging into ArcSight Command Center. Default: 1440 

(admin/password) 1441 



DRAFT 

NIST SP 1800-11C: Data Integrity  249 

 1442 
21. Click Next. 1443 
22. Set identifying details about the system to help identify the connector (include Name; the rest is 1444 

optional). 1445 
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 1446 
23. Click Next. 1447 
24. Select Import the certificate to connector from destination. This will fail if the Manager 1448 

Hostname does not match the hostname of the VM. 1449 
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 1450 
25. Click Next. 1451 
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 1452 
26. Click Next. 1453 
27. Choose Install as a service. 1454 
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 1455 
28. Click Next.  1456 
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 1457 
29. Click Next.  1458 
30. Choose Exit. 1459 
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 1460 
31. Click Next.  1461 

 1462 
32. Click Done. 1463 
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33. Open Task Manager. 1464 
34. Click More Details. 1465 
35. Go to the Services tab. 1466 
36. Find the service just created for ArcSight and right click it. 1467 

 1468 
37. Choose Start. 1469 
38. Open the Tripwire Log Center Console.  1470 
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 1471 
39. Go to the Configuration Manager. 1472 
40. Select Resources > Managers. 1473 

 1474 
41. Double click the Primary Manager listed.  1475 
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 1476 
42. Click the Advanced Settings tab.  1477 
43. Click the +Add button. This should add a row to the table. 1478 
44. In the Advanced Option box, select Log Message Forwarding - Destinations.  1479 
45. In the Value box next to it, type <ip_address>:<port>:udp, with the IP Address and port of the 1480 

syslog daemon just created.  1481 

2.11.2  Configuring Tripwire Enterprise and HPE ArcSight ESM to Detect and Report 1482 
File Integrity Events 1483 

2.11.2.1  Creating a Rule for Which Files to Monitor Across Your Enterprise 1484 

1. Log into Tripwire Enterprise by going to https://tripwire and entering the user name and 1485 
password.  1486 

2. Click the Rules link. 1487 
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 1488 
3. Click New Rule. 1489 
4. Select Types > File Server > Windows File System Rule. 1490 

 1491 
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5. Click OK.  1492 
6. Enter a name for the rule.  1493 

 1494 
7. Click Next. 1495 

 1496 
8. Click New Start Point. This will bring up a New Start Point Wizard. 1497 
9. Enter the path to a folder or file that will be monitored across all Windows Systems. For 1498 

example, we chose to monitor C:\Users. 1499 
10. If you selected a directory and want the integrity check to recurse in all sub directories, make 1500 

sure the box next to Recurse directory is checked.  1501 
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 1502 
11. Click Next. 1503 
12. Select Windows Content and Permissions. 1504 

 1505 
13. Click Next.  1506 
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 1507 
14. Click Finish. 1508 
15. If you wish to exclude directories, click New Stop Point.  1509 

 1510 
16. Enter the path name of directories you wish to exclude. For example, we chose to exclude 1511 

C:\Users\*\AppData because that provided many false flags of routine application data 1512 
modification. 1513 

17. Check the box next to Stop Recursion. 1514 
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 1515 
18. Click Finish.  1516 
19. The rule created defines a space for the tasks we will create to search through. 1517 

2.11.2.2  Creating a Baseline Task 1518 

1. Click the Tasks link. 1519 

 1520 
2. Click New Task.  1521 
3. Select Baseline Rule Task. 1522 
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 1523 
4. Click OK. 1524 
5. Enter a name for the baseline rule task.  1525 
6. Select a privileged user in Tripwire Enterprise to run the rule as.  1526 

 1527 
7. Click Next. 1528 
8. Select All Baselines. 1529 



DRAFT 

NIST SP 1800-11C: Data Integrity  265 

 1530 
9. Click Next. 1531 
10. Expand Root Node Group > Smart Node Groups > System Tag Sets > Operating System. 1532 
11. You can select specific types of operating systems to run the task on or specific machines. We 1533 

simply selected Operating System to have it run on all applicable Windows machines. 1534 

 1535 
12. Once you have made your selection, click Next.  1536 
13. Select Selected nodes with rule or rule group. 1537 
14. Click the rule you created earlier. 1538 
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 1539 
15. Click Next.  1540 
16. Decide how often the baseline task should be run. We set it to manually but you can also set a 1541 

very specific schedule by choosing periodic.  1542 

 1543 
17. Click Finish. 1544 
18. This rule will create baselines of the specified objects. Baselines are essentially versions of the 1545 

file that check rules will compare against. Baselines should be primarily taken when the integrity 1546 
of files are known to be good.  1547 

2.11.2.3  Creating a Syslog Action 1548 

1. Click the Actions link. 1549 
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 1550 
2. Click New Action.  1551 
3. Select Syslog Action. 1552 

 1553 
4. Click OK. 1554 
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5. Enter a name for the Syslog Action.  1555 

 1556 
6. Click Next.  1557 
7. Enter the IP address of the Tripwire Log Center server.  1558 
8. Enter the port that Tripwire Log Center receives TCP syslog messages on. 1559 
9. Enter a log name, a level, and a facility code per your needs. These will show up in logs, so you 1560 

can use these to help separate or identify log sources. 1561 

 1562 
10. Click Finish. 1563 

2.11.2.4  Creating a Check Task 1564 

1. Click the Tasks link. 1565 
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 1566 
2. Click New Task.  1567 
3. Select Check Rule Task. 1568 

 1569 
4. Click OK. 1570 
5. Enter a name for the baseline rule task. 1571 
6. Select a privileged user in Tripwire Enterprise to run the rule as.  1572 
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 1573 
7. Click Next. 1574 
8. Expand Root Node Group > Smart Node Groups > System Tag Sets > Operating System. 1575 
9. Here, you can select specific types of operating systems to run the task on or specific machines. 1576 

We simply selected Operating System to have it run on all applicable Windows machines. 1577 

 1578 
10. Once you have made your selection, click Next.  1579 
11. Select Selected nodes with rule or rule group. 1580 
12. Click the rule you created earlier.  1581 
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 1582 
13. Click Next.  1583 
14. Decide how often the check task should be run. We set it to manually, but you can also set a 1584 

very specific schedule by choosing periodic.  1585 

 1586 
15. Click Next. 1587 
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 1588 
16. Click Add. 1589 
17. Select the Syslog Action created earlier. 1590 

 1591 
18. Click OK. 1592 
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 1593 
19. Click Next. 1594 
20. Uncheck the box next to initialize baselines now if you do not wish to immediately take a 1595 

baseline of all systems. 1596 

 1597 
21. Click Finish. 1598 
22. This rule will check the current versions of the selected files against their baselines and log any 1599 

changes to Tripwire Log Center.  1600 

2.11.2.5  Running the Baseline Task 1601 

1. Check the box next to the baseline task you created earlier. 1602 
2. Click Control > Run on the taskbar.  1603 
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3. Wait for the run to finish. You can click the Log link to see the progress.  1604 
4. When it finishes, it will log a message such as “Task 'Baseline Rule Windows' was completed in 1605 

600 seconds.” 1606 

2.11.2.6  Make Changes to Monitored Objects 1607 

1. Open a machine being monitored by the rule you created. 1608 
2. Modify a file or files in the folder that you selected in the rule creation wizard (which are being 1609 

monitored by Tripwire). 1610 

2.11.2.7  Running the Check Task 1611 

1. Check the box next to the check task you created earlier. 1612 
2. Click Control > Run on the taskbar. 1613 
3. Wait for the run to finish. You can click the Log link to see the progress. 1614 
4. If you made changes to a monitored object, the log message should appear at the time the 1615 

changes were made even if the change was made prior to the scan. 1616 

2.11.2.8  Filtering for Tripwire Enterprise Integrity Events in HPE ArcSight ESM 1617 

1. Open the ArcSight ESM machine.  1618 
2. Log in by going to https://vm-esm691c:8443 and entering your username/password.  1619 

 1620 
3. Click Events > Active Channels. 1621 
4. Click New.  1622 
5. Enter a name for the channel. Select a start time to show events, and leave $NOW as the end 1623 

time. 1624 
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 1625 
6. Click Configure Filter.  1626 

 1627 
7. Click the button that says Configure a condition using field. 1628 
8. Double click Device Event Category. 1629 
9. For Operator, choose Contains.  1630 
10. For Value, enter Audit Event.  1631 

 1632 
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11. Click Apply Condition. 1633 
12. Click Update Filter Configuration under the list of fields. 1634 

 1635 
13. Click Save Channel. 1636 
14. Click the channel you just created. It should show all file changes in the time frame you 1637 

specified forwarded from Tripwire Enterprise to Tripwire Log Center to ArcSight ESM. 1638 

2.12  Integration: HPE ArcSight ESM with Veeam and Hyper-V 1639 

This section covers the process for integrating HPE ArcSight ESM with Veeam and Hyper-V. This 1640 
integration assumes the correct implementation of Veeam and ArcSight as described in earlier sections. 1641 
The result is the forwarding of logs generated by Veeam and Hyper-V to ArcSight ESM, as well as custom 1642 
parsers to supplement the information provided by this forwarding process. 1643 

2.12.1  Install ArcSight Connector 1644 
1. Run the installation file ArcSight-7.4.0.7963.0-Connector-Win64 on the Veeam Server. 1645 

 1646 
2. Wait for the initial setup to finish. 1647 
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 1648 
3. Click Next. 1649 
4. Choose a destination folder. Note: It is recommended to change the default to 1650 

<default>\HYPERV so that other installed connectors do not overwrite this one. 1651 

 1652 
5. Click Next. 1653 
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 1654 
6. Click Next. 1655 

 1656 
7. Click Install. 1657 
8. Wait for the installation to finish. 1658 
9. Select Add a Connector. 1659 
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 1660 
10. Click Next. 1661 
11. Choose Microsoft Windows Event Log - Native from the list. 1662 
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 1663 
12. Click Next. 1664 
13. Check Security log, System log, Application Log, and Custom Log. 1665 
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 1666 
14. Click Next. 1667 
15. Click on the box underneath Custom Event Logs.  1668 
16. Enter Veeam Backup, Microsoft-Windows-Hyper-V-VMMS-Admin, Microsoft-Windows-1669 

Hyper-V-Integration-Admin, Microsoft-Windows-Hyper-V-SynthNic-Admin, Microsoft-1670 
Windows-Hyper-V-Worker-Admin. 1671 

 1672 
17. You can add more application logs through the following process: 1673 

a. Open Microsoft Event Viewer. 1674 
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 1675 
b. Find the log you wish to add. 1676 

 1677 
c. Open the Details pane of a log and find the field Channel. 1678 
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 1679 
d. Note that this may differ from the Log Name in the General pane. (For example, one of 1680 

the Hyper-V log's Log Name is Microsoft-Windows-Hyper-V-VMMS/Admin but the 1681 
channel name is Microsoft-Windows-Hyper-V-VMMS-Admin.) 1682 

e. Enter all these channel names separated by commas in the Custom Event Logs field. 1683 
18. Click Next. 1684 
19. Choose ArcSight Manager (encrypted). 1685 

 1686 
20. Click Next. 1687 
21. For Manager Hostname, put vm-esm691c, or the hostname of your ESM server. 1688 
22. For Manager Port, put 8443, or the port that ESM is running on, on the ESM server. 1689 
23. Enter the username and password used for logging into ArcSight Command Center 1690 

(admin/password). 1691 
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 1692 
24. Click Next. 1693 
25. Set identifying details about the system to help identify the connector (include at least Name; 1694 

the rest is optional). 1695 

 1696 
26. Click Next. 1697 
27. Select Import the certificate to connector from destination. This will fail if the Manager 1698 

Hostname does not match the hostname of the VM. 1699 
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 1700 
28. Click Next. 1701 
29. Wait for the process to complete. 1702 

 1703 
30. Click Next. 1704 
31. Choose Install as a service. 1705 
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 1706 
32. Click Next.  1707 

 1708 
33. Click Next. 1709 
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 1710 
34. Click Next.  1711 
35. Choose Exit. 1712 
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 1713 
36. Click Next.  1714 

 1715 
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37. Click Done. 1716 
38. Open Task Manager. 1717 
39. Click More Details. 1718 

 1719 
40. Go to the Services tab. 1720 
41. Find the service just created arc_winc for ArcSight, and right click it. 1721 
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 1722 
42. Choose Start. 1723 
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 1724 
43. The machine will now report its logs to ArcSight ESM. 1725 
44. For more fine-grained reporting, such as including more information about the event, you may 1726 

wish to include custom parsers that are described below. 1727 

2.12.2  Create a Parser for Veeam Logs 1728 
1. For a Veeam custom parser that handles event numbers 210, 251, and 290, create a 1729 

configuration file with the following text: 1730 

trigger.node.location=/EventData 1731 

event.deviceVendor=__getVendor("Veeam") 1732 

conditionalmap.count=1 1733 

conditionalmap[0].field=event.externalId 1734 

conditionalmap[0].mappings.count=3 1735 

conditionalmap[0].mappings[0].values=210 1736 

conditionalmap[0].mappings[0].event.name=__stringConstant("Restore session 1737 
initiated.") 1738 
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conditionalmap[0].mappings[1].values=251 1739 

conditionalmap[0].mappings[1].event.name=__stringConstant("Restore session 1740 
has finished with success state.") 1741 

conditionalmap[0].mappings[2].values=290 1742 

conditionalmap[0].mappings[2].event.name=__stringConstant("Restore session 1743 
has finished with success state.") 1744 

 1745 
2. Save this file as C:\Program Files\ArcSightSmartConnectors\<name of 1746 

folder>\current\user\agent\fcp\winc\veeam_backup\veeam_mp.sdkkeyvaluefilereader.propert1747 
ies 1748 

 1749 
3. Copy this file to C:\Program Files\ArcSightSmartConnectors\<name of 1750 

folder>\current\user\agent\winc\veeam_backup\veeam_mp.sdkkeyvaluefilereader.properties 1751 
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 1752 

2.12.3  Create a Parser for Hyper-V Logs 1753 
1. For a Hyper-V VMMS custom parser, create a configuration file with the following text: 1754 

trigger.node.location=/EventData 1755 

event.deviceVendor=__getVendor("Microsoft") 1756 

token.count=1 1757 

token[0].name=VmName 1758 

token[0].location=VmlEventLog/VmName 1759 

token[0].type=String 1760 

conditionalmap.count=1 1761 

conditionalmap[0].field=event.externalId 1762 

conditionalmap[0].mappings.count=1 1763 

conditionalmap[0].mappings[0].values=13003 1764 

conditionalmap[0].mappings[0].event.name=__concatenate(__stringConstant("The 1765 
virtual machine '"), VmName, __stringConstant("' has been deleted.")) 1766 
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 1767 
2. Save this file as C:\Program Files\ArcSightSmartConnectors\<name of 1768 

folder>\current\user\agent\fcp\winc\microsoft_windows_hyper_v_vmms_admin\microsoft_wi1769 
ndows_hyper_v_vmms.userdata.jsonparser.properties 1770 

 1771 
3. Copy this file to C:\Program Files\ArcSightSmartConnectors\<name of 1772 

folder>\current\user\agent\winc\microsoft_windows_hyper_v_vmms_admin\microsoft_windo1773 
ws_hyper_v_vmms.userdata.jsonparser.properties 1774 
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 1775 

These two parsers will allow for details of VM deletions and VM restores to be shown in ArcSight. 1776 
Custom parsers are a functionality of ArcSight. For more information on the creation of custom parsers, 1777 
please see the ArcSight FlexConnector Developer's Guide, as well as the SmartConnector for Microsoft 1778 
Windows Event Log - Native, Configuration Guide (for information specific to Windows event logs). 1779 

2.13  Integration: GreenTec WORMdisks and IBM Spectrum Protect 1780 

This section covers the process for integrating IBM Spectrum Protect and GreenTec WORMdisks. The 1781 
result is the capability to backup clients directly to WORMdisks in order to preserve data more securely. 1782 
This integration process does not include instructions related to locking the WORMdisks – that process is 1783 
found in the GT_WinStatus User Guide, that should accompany the installation disk. Scheduling the 1784 
locking of these disks is left up to the discretion of the adapting organization. 1785 

2.13.1  Install IBM Spectrum Protect Server on the GreenTec Server 1786 
1. You may need to disable Run all administrators in Admin Approval Mode. To do this go to 1787 

Control Panel > Administrative Tools > Local Security Policy > Local Policies > Security 1788 
Options. Double click the User Account Control: Run all administrators in Admin Approval 1789 
Mode section. Select Disable and click OK. Restart the computer. 1790 
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 1791 

 1792 
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 1793 

 1794 
2. Run WIN_SER_STG_ML in its own folder to extract the contents. 1795 
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 1796 
3. Run the install script.  1797 

 1798 
4. Make sure all the boxes are checked. 1799 
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 1800 
5. Click Next.  1801 
6. Read and select I accept the terms in the license agreement. 1802 

 1803 
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7. Click Next.  1804 
8. Select the installation location for files. 1805 

 1806 
9. Click Next. 1807 
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 1808 
10. Click Next. 1809 
11. Make sure all the packages are checked.  1810 

 1811 



DRAFT 

NIST SP 1800-11C: Data Integrity  302 

12. Click Next. 1812 
13. Select IBM Spectrum Protect. 1813 

 1814 
14. Click Next.  1815 
15. Read and select I accept the terms in the license agreement. 1816 
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 1817 
16. Click Next.  1818 
17. Read and select I accept the terms in the license agreement. 1819 

 1820 
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18. Click Next. 1821 
19. Specify 11090 for the port.  1822 

 1823 
20. Click Next.  1824 
21. Select Strict for the SP800-131a Compliance. 1825 
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 1826 
22. Click Next.  1827 
23. Create a password. 1828 

 1829 
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24. Click Next.  1830 

 1831 
25. Click Install. 1832 
26. After the successful installation, click Finish. 1833 

2.13.2  Configure IBM Spectrum Protect 1834 
1. Go to Start > IBM Spectrum Protect Configuration Wizard. 1835 
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 1836 
2. Click OK. 1837 

 1838 
3. Click Next. 1839 
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4. Specify a name and an account for the IBM server to use. Example: (name: GRNBACK, User ID: 1840 
DI\sp_admin) 1841 

 1842 
5. Click Next. 1843 
6. Choose a directory. 1844 
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 1845 
7. Click Next. 1846 
8. Click Yes if prompted to create the directory. 1847 
9. Choose The database directories are listed below. 1848 
10. Create a directory to contain the database. Example: C:\BACKSERV\IBMBackupServer. 1849 
11. Enter the directory in the space provided. 1850 
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 1851 
12. Click Next. 1852 
13. Create directories for logs and archive logs. Example: C:\BACKSERV\IBMBackupServerLogs, 1853 

C:\BACKSERV\IBMBackupServerArchiveLogs. 1854 
14. Enter the directories in their respective fields. 1855 
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 1856 
15. Click Next. 1857 
16. Specify the server name.  1858 
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 1859 
17. Click Next. 1860 
18. Specify an Administrator account. 1861 

 1862 
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19. Click Next.  1863 
20. Select a port (example: 1500). 1864 
21. Check the box next to Enable SSL Communication and enter a port (example: 23444). 1865 

 1866 
22. Click Next. 1867 
23. Click Next.  1868 
24. Wait for the installation to finish. 1869 
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 1870 
25. Click Next. 1871 
26. Click Done. 1872 
27. Log in to Operations Center by going to localhost:11090/oc/. 1873 
28. Log in using the credentials provided in the Configuration Wizard. 1874 

 1875 
29. Enter the password for a new account to be created on the system. 1876 
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 1877 
30. Click Next. 1878 
31. Select the time interval for data collection. 1879 

 1880 
32. Click Next. 1881 



DRAFT 

NIST SP 1800-11C: Data Integrity  316 

33. Select time intervals that suit your organization's needs. 1882 

 1883 
34. Click Configure. 1884 

 1885 
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2.13.3  Connect the GreenTec Server to the IBM Spectrum Protect Server 1886 
1. Go back to the primary IBM server. 1887 

 1888 
2. Click Servers. 1889 

 1890 
3. Click +Spoke. 1891 
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 1892 
4. Enter the IP address of the server with GreenTec disks attached. 1893 
5. Enter the port that the server is configured to listen for connections on (Example: 1500). 1894 
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 1895 
6. Click Next. 1896 
7. Enter the password for the new server twice.  1897 
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 1898 
8. Click Next. 1899 

 1900 
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9. Click Connect Spoke. 1901 

 1902 
10. Click Close.  1903 

2.13.4  Define a Volume on the GreenTec Server 1904 
1. Issue the following command in the Operations Center (on the GreenTec server) command 1905 

builder to create a device class for the backup disk (replace the name golden, max capacity 1906 
value, and directory value as you see fit).  1907 
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 1908 
> define devclass golden devtype=file maxcapacity=350000M shared=yes 1909 
mountlimit=1 directory="E:\" library=backuplib  1910 

 1911 
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2. Go to Storage > Storage Pools. 1912 

 1913 
3. Click +Storage Pool. 1914 
4. Enter a name.  1915 

 1916 
5. Click Next. 1917 
6. Select Disk (primary). 1918 
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 1919 
7. Click Next.  1920 
8. Select the device class you just created.  1921 

 1922 
9. Click Next.  1923 
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 1924 
10. Click Next.  1925 

 1926 
11. Click Add Storage Pool. 1927 
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 1928 
12. Click Close & View Policies. 1929 
13. Issue the following command in the Operations Center command builder to create a volume on 1930 

the backup disk.  1931 
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define volume goldenstg golden1 location="E:\" formatsize=350000 1932 
access=readwrite numberofvolumes=1 wait=no1933 

 1934 
14. The storage pool may indicate that there is no capacity, but once you backup something it 1935 

should correctly show the capacity.  1936 

2.13.5  Create a Policy to Backup to GreenTec disks 1937 
1. Issue the following command in the Operations Center (on the GreenTec server) command 1938 

builder to delete the standard policy domain: 1939 

delete domain standard 1940 

2. Issue the following command to create a new domain. 1941 
define domain golden 1942 

3. Issue the following command to create a new policy set in this domain. 1943 
define policyset goldenpolicy 1944 

4. Issue the following command to create a management class in this domain. 1945 
define mgmtclass golden goldenpolicy goldenclass 1946 
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 1947 

5. Click Services > Policy Sets. 1948 
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 1949 
6. Toggle the Configure button. This should allow you to edit the settings of the newly created 1950 

management class. 1951 
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 1952 
7. Select Default.  1953 
8. For Backup Destination, select the storage pool you just created.  1954 
9. For Backups, select 1.  1955 
10. Select the rest of the settings per your organization's needs. 1956 
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 1957 
11. Click the Activate button.  1958 
12. Check the box next to I understand that these updates can cause data deletion. 1959 

 1960 
13. Click Activate. 1961 
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2.13.6  Create a Schedule That Uses the New Policy 1962 
1. On the primary IBM Spectrum Protect Server log in to the Operations Center. 1963 

 1964 
2. Go to Clients > Schedules. 1965 

 1966 
3. Click +Schedule. 1967 
4. Enter a name for the schedule. 1968 
5. For Server, select the GreenTec server. 1969 
6. For Domain, select the policy domain you just created. 1970 
7. For Type, select System. 1971 
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 1972 
8. Click Next. 1973 
9. Select Daily incremental backup.  1974 
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 1975 
10. Click Next. 1976 
11. Configure the schedule settings for your organization's needs. This can be changed later. 1977 
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 1978 
12. Click Add Schedule. 1979 
13. From the command builder, run the following command to update the schedule: 1980 

update schedule golden golden starttime=now action=backup type=client 1981 
objects="c:\*" startdate=06/10/2017 perunits=onetime 1982 

2.13.7  Installing Open File Support on the Client  1983 
1. Open the client machine (with the IBM Backup Archive Client installed) to make a golden disk.  1984 
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 1985 
2. Open the IBM BA Client. 1986 
3. Click Utilities > Setup Wizard.  1987 
4. Check the box next to Help me configure Open File Support. 1988 

 1989 
5. Click Next. 1990 
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 1991 
6. Click Next.  1992 
7. Select Volume Shadowcopy Services (VSS). 1993 

 1994 
8. Click Next.  1995 
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 1996 
9. Click Apply.  1997 

 1998 
10. Click Finish.  1999 
11. Restart the BA Client. 2000 
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 2001 
12. Click Edit > Client Preferences. 2002 
13. Click the Include-Exclude tab.  2003 

 2004 
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14. Click Add.  2005 
15. For Category, select Backup. 2006 
16. For Type, select Include.FS. 2007 
17. For Snapshot Provider Type, choose VSS.  2008 
18. For File or Pattern, enter *:\*.  2009 

 2010 
19. Click OK.  2011 

2.13.8  Temporarily Add Client to GreenTec IBM Server 2012 
1. Assuming your GreenTec disks are on a separate IBM server, you will need to connect the client 2013 

you wish to migrate in order to use the created schedule. On the GreenTec server, click Clients. 2014 

 2015 
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2. Click +Client. 2016 
3. Select the GreenTec server.  2017 

 2018 
4. Click Next.  2019 
5. Enter the information for the client you are migrating to this server. 2020 

 2021 
6. Click Next. 2022 
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7. Take note of the information presented here, namely the IP and port provided, as you will need 2023 
it on the client machine to connect to the server. 2024 

 2025 
8. Click Next.  2026 
9. Select the policy domain you created. 2027 

 2028 
10. Click Next. 2029 
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11. Select the schedule created earlier.  2030 

 2031 
12. Click Next.  2032 

 2033 
13. Click Next. 2034 
14. Select the at-risk options per your organization's needs. 2035 
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 2036 
15. Click Add Client.  2037 

 2038 
16. Click Close. 2039 
17. On the client machine, open the BA client.  2040 
18. Click Edit > Client Preferences. 2041 
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19. Click the Communication tab, and enter the new server address and port. Only leave Use SSL 2042 
checked if you have set it up for this new server. Similarly, unselect SSL is required if you did not 2043 
setup SSL on this second server. 2044 

 2045 
20. Restart the BA client. The client should now connect to the new server. 2046 
21. You may be prompted for a password. Enter the password and press Enter.  2047 
22. To start the schedule, issue the following command in the Operations Center command builder: 2048 

 update schedule golden golden startdate=today starttime=now 2049 

2.14  Integration: Backing Up and Restoring System State with GreenTec 2050 

This section covers the process for backing up (and restoring) the Windows System State on a Windows 2051 
Server with GreenTec as a backup medium. The backup of user information as well as other system state 2052 
information to a networked GreenTec WORMdisk is intended for the recovery of damage to the 2053 
Windows system state, such as account permission modification, account creation, account deletion, 2054 
and various other applicable scenarios. 2055 
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2.14.1  Installing Windows Server Essentials for System State Backup Capability 2056 
(NOTE: For older machines, IBM Spectrum Protect's option to backup SystemState may be sufficient. 2057 
However, for newer, more complex versions of Windows, such as Windows Server 2012 and Windows 2058 
8+, you should use the following procedure.) 2059 

1. Open Server Manager. 2060 

 2061 
2. Select Manage > Add Roles and Features. 2062 

 2063 
3. Click Next.  2064 
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4. Select Role-based or feature-based installation. 2065 

 2066 
5. Click Next. 2067 
6. Select the server. 2068 

 2069 
7. Click Next. 2070 
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8. Select Windows Server Essentials Experience. 2071 

 2072 
9. Click Next.  2073 

 2074 
10. Click Next. 2075 
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 2076 
11. Click Next. 2077 
12. Click Install.  2078 

 2079 
13. Click Configure Windows Server Essentials Experience.  2080 
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 2081 
14. Click Configure. 2082 

 2083 
15. Click Close. 2084 
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2.14.2  Configure Network Accessible GreenTec Disk 2085 
1. To configure a GreenTec disk to be network accessible, right click the disk on the GreenTec 2086 

server.  2087 

 2088 
2. Click Share With > Advanced Sharing.  2089 
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 2090 
3. Click Advanced Sharing.  2091 
4. Check the box next to Share this folder. 2092 
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 2093 
5. Click OK.  2094 
6. Click Close. 2095 

2.14.3  Backup the System State 2096 
1. Go to command prompt on the Active Directory server and enter the following command: 2097 

  wbadmin start systemstatebackup -backuptarget:z: 2098 
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  2099 

 (Instead of z:, put the location of a disk for the system state backup. You will get an error if you 2100 
attempt to use the same location as the disc you are trying to backup. Examples of acceptable targets: 2101 
C:, Z:, \\backup-storage\g) 2102 

  2103 

2.14.4  Restoring the System State 2104 
1. After determining the point in time of a malicious event, restart the Active Directory Server and 2105 

press F2 > F8 to start the Advanced Boot menu.  2106 
2. Select Directory Services Repair Mode.  2107 
3. Log in as the machine administrator. 2108 
4. Open a command prompt. 2109 
5. Enter the following command to see the backup versions available: 2110 

wbadmin get versions 2111 
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  2112 

6. Enter the following command to restore to a specific version (preferably before the malicious 2113 
event occurred):  2114 

 wbadmin start systemstaterecovery -version:06/21/2017-15:33 -2115 
backupTarget:\\192.168.52.12\g 2116 

(Replace the backupTarget with the location of the backup, and the version with the version to 2117 
restore to.) 2118 

  2119 

7. The computer will restart when you finish the restore process. 2120 

2.15  Integration: Copying IBM Backup Data to GreenTec WORMdisks 2121 

This section covers the process for integrating IBM Spectrum Protect with GreenTec WORMDisks. This 2122 
integration assumes the correct implementation of IBM Spectrum Protect, as well as the existence of 2123 
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GreenTec WORMdisks as described in earlier sections. The result of this integration is the capability to 2124 
store all backup data created by IBM Spectrum Protect for a single client on a secure WORMDisk. 2125 

2.15.1  Copying Backups for a Single Machine to a GreenTec WORMDisk 2126 
1. On the IBM Spectrum Protect server, log on to IBM Spectrum Protect Operations Center. 2127 
2. Create a new device class by running the following command in the Command Builder: 2128 

define devclass backupset devtype=file maxcapacity=100000M shared=yes 2129 
mountlimit=1 directory="C:\" 2130 

 2131 
3. Go to Storage > Storage Pools. 2132 

 2133 
4. Click +Storage Pool. 2134 
5. Enter a name.  2135 
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 2136 
6. Click Next. 2137 
7. Select Disk (primary). 2138 

 2139 
8. Click Next.  2140 
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 2141 
9. Click Next. 2142 

 2143 
10. Click Add Storage Pool. 2144 
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 2145 
11. Create a backup set for the client whose data you wish to store securely. Run the following 2146 

command on Command Builder: 2147 

generate backupset <name of client> <identifier> \\<name of client>\c$ 2148 
devclass=file volumes=backupset1 nametype=unicode 2149 

 For example: 2150 

generate backupset windowsvm1 windowsvm1_backupset \\windowsvm1\c$ 2151 
devclass=file volumes=backupset1 nametype=Unicode 2152 
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  2153 

12. This will store all backup data for the client WINDOWSVM1 in a file called backupset1. You can 2154 
copy this file to a GreenTec disk and store for later use.  2155 

2.16  Integration: Tripwire and MS SQL Server 2156 

This section covers the process for integrating Tripwire Log Center and Microsoft SQL Server. This 2157 
integration assumes the correct implementation of Tripwire as described in earlier sections. The result 2158 
of this integration is the collection of database audit logs in Tripwire, allowing for detection and 2159 
reporting of events such as specific types of queries, schema modification, and database modification. 2160 

2.16.1  Create a New Account on MS SQL Server 2161 
1. Open SQL Server Management Studio. 2162 
2. Hit Connect to connect to the database. 2163 
3. In the Object Explorer window, expand the Security folder. 2164 
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 2165 
4. Right click on the Logins folder and click New Login…. 2166 
5. Input the desired user. 2167 
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 2168 
6. Click User Mapping. 2169 
7. For each database that Tripwire should monitor, click the database and assign the role 2170 

db_datareader. 2171 
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 2172 
8. Click Securables. 2173 
9. Under the Grant column, check the boxes next to Alter trace and View any definition (if this is 2174 

not available, create the user, then edit properties for that user). 2175 



DRAFT 

NIST SP 1800-11C: Data Integrity  364 

 2176 
10. Click OK. 2177 

2.16.2  Create a New Audit on MS SQL Server 2178 
1. In the Object Explorer window, expand the Security folder. 2179 
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 2180 
2. Right click on the Audits folder. 2181 
3. Click New Audit…. 2182 
4. Specify a filename or any other settings per your organization’s needs. Note: If you specify a 2183 

filename, you will be able to view any queries you wish to monitor in this Audit log, but not in 2184 
Tripwire. However, if you set the Audit Destination to Application Log, the messages will be 2185 
forwarded to the Microsoft Application Log. This will result in less structured (but still detailed) 2186 
messages and allows the capability to collect them easily using HPE ArcSight ESM. If your 2187 
ArcSight Connector is configured to collect Application Logs from the MS SQL server, no further 2188 
configuration of the connector is required. 2189 
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 2190 
5. Click OK.  2191 
6. Right click Security > Server Audit Specifications. 2192 
7. Click New Server Audit Specification…. 2193 
8. For Audit: select the audit you just created. 2194 
9. Specify any Audit Action Types that Tripwire should be able to log. 2195 
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 2196 
10. Click OK. 2197 
11. Open a database that you wish to monitor specific objects in. 2198 
12. Right click Databases > <Database name> > Security > Database Audit Specifications. 2199 
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 2200 
13. Click New Database Audit Specification….  2201 
14. Select an Audit Action Type to monitor. 2202 
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 2203 
15. Select Object for the Object Class.  2204 
16. In the Object Name field, use the Browse button to find objects that you wish to monitor for the 2205 

specified Audit Action Type. 2206 
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 2207 
17. Create as many types as you wish Tripwire to monitor. 2208 
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 2209 
18. Click OK. 2210 
19. Find the audits you just created in the Object Explorer and right click. 2211 
20. Select Enable ___ Audit Specification for each one.  2212 

2.16.3   Create a New Node for the MS SQL Server on Tripwire Enterprise 2213 
1. Open the Tripwire Enterprise console. 2214 
2. Click Nodes. 2215 
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 2216 
3. Click Manage > New Node. 2217 

 2218 
4. Click Types > Database Server > Microsoft SQL Server. 2219 
5. Click Ok. 2220 
6. Enter the hostname or IP of the MS SQL Server.  2221 
7. Enter the instance name of the database. 2222 
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 2223 
8. Click Next.  2224 
9. Enter the port the database listens on.  2225 

 2226 
10. Click Next. 2227 
11. Enter the newly created username and password for the database.  2228 
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 2229 
12. Click Next. 2230 
13. Check the box next to Collect audit-event information. 2231 

 2232 
14. Click Next.  2233 
15. Find the MSSQL Server on the list. 2234 
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 2235 
16. Click Next.  2236 
17. Test Login to ensure the information you entered was correct. 2237 

 2238 
18. Click Finish.   2239 
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Appendix A  List of Acronyms 2240 

AD Active Directory 2241 

BA  Client Backup-Archive Client 2242 

DB Database 2243 

DI Data Integrity 2244 

DNS Domain Name System 2245 

EOF End of File 2246 

ESM Enterprise Security Manager 2247 

HPE Hewlett Packard Enterprise 2248 

IP Internet Protocol 2249 

IT Information Technology  2250 

LDAP Lightweight Directory Access Protocol 2251 

MS SQL Microsoft Structured Query Language 2252 

NCCoE National Cybersecurity Center of Excellence  2253 

NIST National Institute of Standards and Technology 2254 

MS Microsoft 2255 

CA Certificate Authority 2256 

DSRM Directory Services Restore Mode  2257 

IIS Internet Information Services 2258 

IP  Internet Protocol 2259 

SQL Structured Query Language 2260 

SDK Software Development Kit 2261 

TCP  Transmission Control Protocol 2262 

SSL  Secure Sockets Layer 2263 

TLS  Transport Layer Security 2264 

VSS  Volume Shadowcopy Services 2265 
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VM Virtual Machines 2266 

VnE Vulnerability and Exposure 2267 

WORM Write Once Read Many 2268 
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